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ABSTRACT 

Land use and land cover (LULC) changes significantly influence urban planning, environmental 

management, and sustainable development. This study examines LULC dynamics in Delta State, 

Nigeria, over multiple years using Sentinel-2 satellite imagery and Geographic Information System 

(GIS) techniques. As one of Nigeria’s rapidly urbanizing regions, Delta State has witnessed 

extensive land cover transformations, driven by urban expansion, infrastructure growth, and 

economic activities. 

 

Utilizing Sentinel-2 images from 2018, 2021, and 2024, alongside a projected land-cover model for 

2030, this study employs supervised classification techniques to analyze land-cover transitions over 

time. Findings reveal that built-up areas increased by approximately 29% from 2018 to 2024, largely 

driven by urban expansion and infrastructural development. Conversely, dense vegetation cover 

declined by about 10.6%, primarily due to deforestation and land conversion for agricultural and 

residential purposes. Cropland expanded significantly by 27.8%, reflecting the ongoing 

transformation of vegetated areas into farmland, while bare land rose by 43%, associated with 

vegetation degradation and construction activities. Water bodies exhibited a moderate increase of 

33.6%, likely influenced by expanded reservoirs and hydrological variations. 

Future projections for 2030 suggest that built-up areas will continue expanding at an accelerated 

rate, with a potential 31.7% increase from 2024, further intensifying pressure on natural ecosystems. 

Dense vegetation is expected to decline slightly, while cropland continues to expand, underscoring 

growing agricultural demands. Bare land may decrease as some areas transition to built-up or 

reclaimed zones, and water bodies are projected to increase marginally. These trends, if sustained, 

could exacerbate environmental challenges such as biodiversity loss, flooding, and urban heat island 

effects, emphasizing the need for sustainable land-use planning and effective conservation 

measures. 
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CHAPTER ONE 

INTRODUCTION 

 
1.1 BACKGROUND OF THE STUDY 

 

Land is an essential natural resource that underpins all human activities, serving as the foundation 

for economic resources. The way land is managed reflects the application of land tenure rules, 

ensuring operational functionality. Land administration, whether formal or informal, encompasses a 

broad array of systems and processes essential for maintaining effective governance. Dissemination 

and utilization of land information play a crucial role in ensuring tenure security, regulating 

property markets, guiding land-use planning, and establishing taxation frameworks. 

 

Changes in land use and land cover represent two fundamental aspects of landscape transformation. 

Land use pertains to human interactions with land, including activities such as settlements, farming, 

grazing, and recreation (Meyer et al., 1994). The transformation of land occurs through various 

processes, including urban expansion, conversion to agricultural purposes, intensification of farming 

practices, and abandonment of cultivated land (Diogo, 2018). Land cover, however, refers to the 

physical components found on the Earth's surface, including vegetation, built structures, exposed 

soil, and water bodies. The term "earth cover," introduced by ecologist Frederick Edward Clements, 

has evolved to describe the actual state of land surfaces, incorporating soil composition, vegetation 

density, and water availability. 

 

The study of land-use and land-cover change (LUCC) investigates the interaction between human 

development and the environment (Sun et al., 2021). It explores how deforestation, agricultural 

expansion, and urbanization reshape landscapes, leading to shifts in water cycles, loss of 

biodiversity, and alterations in climate conditions. Monitoring these changes provides insight into 

spatial distribution and landscape patterns, aiding planners in making informed decisions about 

urban development and ecological preservation (Piao et al., 2023). 
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Delta State has experienced rapid expansion, significantly influencing its land-use and land-cover 

patterns. A growing population has fueled continuous land reclamation efforts to accommodate 

increasing demands for housing, infrastructure, and commercial spaces. This surge in development 

has heightened environmental risks, including severe flooding, erosion, and pollution. In 

developing nations such as Nigeria, the absence of timely and reliable spatial data has hindered 

efforts to regulate urban growth and implement effective land policies. 

 

Remote sensing and Geographic Information System (GIS) technologies have become 

indispensable in assessing landscape transformations. Remote sensing enables the classification and 

mapping of spectral images, facilitating the identification of deforested zones, environmental 

pollution, fire outbreaks, and agricultural productivity (Rwanga & Ndambuki, 2017). Despite 

advancements in geospatial technologies, complexities in processing large datasets pose challenges 

in ensuring accuracy. GIS complements remote sensing by providing tools for storing, visualizing, 

and analyzing land-use transitions (Reis, 2008). Urbanization remains a dominant driver of land-

use changes, as expanding populations lead cities to encroach on agricultural and forested 

territories. Studies have shown that GIS-based models can forecast future urban expansion, 

assisting planners in sustainable city management (Bello & Aina, 2014). 

 

Land-use and land-cover analysis is instrumental in shaping policies for resource management, 

environmental monitoring, and development planning. As a vital geographic asset and a crucial 

source of livelihood, land classification is essential for determining conversion rates necessary for 

sustainable growth. Every developing nation should integrate modern techniques in land-cover 

classification to establish comprehensive land-use frameworks that address both developmental and 

conservation priorities. 

 

For accurate assessments of land transformation, updated spatial data is required to track specific 

changes occurring within a region. Remote sensing techniques facilitate this process by extracting 
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change information from satellite imagery, while GIS tools support data processing and 

visualization. These technologies provide essential insights for policymakers and urban planners, 

enabling them to anticipate future challenges and develop strategies to balance urban expansion 

with environmental sustainability. 

 

 

1.2 STATEMENT OF THE PROBLEM 

 

Delta State, located in the South-South region of Nigeria, is a rapidly developing area with a diverse 

population and significant economic activities. It has an estimated population of approximately 7.4 

million people and a landmass of about 16,842 square kilometers. As a key hub for oil production, 

agriculture, and commerce, Land use and land cover in Delta State have undergone significant 

changes due to urbanization, industrial growth, agricultural expansion, and deforestation. However, 

the absence of accurate and timely monitoring has made it difficult to manage land resources 

effectively, leading to environmental degradation and poor planning decisions. Traditional methods 

have struggled to capture the dynamic shifts in land use, leaving gaps in sustainable development 

strategies. 

 

Geospatial techniques, particularly remote sensing and Geographic Information Systems (GIS), 

offer valuable tools for analyzing and predicting these changes. Despite their potential, their 

application in Delta State remains limited, restricting the ability of policymakers, urban planners, 

and environmentalists to make informed decisions. 

 

This study aims to fill this gap by employing geospatial methods to assess past and present land use 

trends while forecasting future changes. By providing critical insights, it will support more 

sustainable land management, urban planning, and environmental conservation efforts in Delta 

State. 
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1.3 AIM AND OBJECTIVES OF THE STUDY 

This study aims to analyze and predict land use and land cover (LULC) changes in Delta State for 

2030 using geospatial techniques. By leveraging remote sensing and Geographic Information 

Systems (GIS), the study seeks to provide valuable insights into past trends, present conditions, 

and future projections to support sustainable land management and environmental planning. 

The objectives are to: 

 

i. To assess historical and current LULC patterns in Delta State using geospatial data. 

 

ii. To identify major drivers influencing LULC changes, including urbanization, industrial 

activities, agriculture, and deforestation. 

iii. To develop predictive models using geospatial techniques to forecast future LULC changes. 

 

iv. To provide data-driven recommendations for policymakers,

 urban planners, and environmental managers to enhance sustainable land use 

practices. 

 

1.4 SCOPE AND LIMITATIONS OF THE STUDY 

 
This study examines land use and land cover changes in Delta State using geospatial techniques, specifically 

remote sensing and GIS. Sentinel-2 imagery from 2018 and 2024 serves as the primary data source for 

analyzing trends and forecasting future transformations. The imagery was obtained from the European 

Space Agency’s Copernicus Open Access Hub, ensuring reliable datasets. ArcGIS was employed for image 

processing and spatial analysis, allowing precise mapping of land use dynamics. While Sentinel-2 provides 

valuable insights, limitations such as cloud cover interference, modeling uncertainties, and the need for 

ground validation exist. Temporal gaps between selected years may not fully capture rapid changes, though 

supplementary datasets enhance continuity. Despite these constraints, integrating remote sensing and GIS 

offers a robust framework for understanding LULC patterns and supporting sustainable land management 

strategies in Delta State. 
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1.5 JUSTIFICATION OF THE STUDY 

 

Delta State has undergone significant land use and land cover changes due to urbanization, 

industrial expansion, agriculture, and deforestation. These shifts have led to environmental 

challenges such as erosion, flooding, and biodiversity loss. Existing studies often fail to provide a 

comprehensive assessment of these changes and their long-term effects. Geospatial techniques, 

particularly remote sensing and GIS, offer a reliable approach for analyzing and predicting land 

use dynamics. By utilizing these tools, this study will generate accurate, spatially informed insights 

to support effective land management. The findings will be essential for policymakers, urban 

planners, and environmental stakeholders. 

 

This study is justified by its ability to enhance land use planning, mitigate environmental risks, 

and contribute to a sustainable future for Delta State. Through data-driven analysis, it aims to 

provide actionable recommendations for balanced development and conservation efforts 
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CHAPTER TWO 

LITERATURE REVIEW 

 
2.1 THE CONCEPT OF LAND AND LAND USE 

 

Land is one of the most vital natural resources, forming the foundation of life and development. It 

plays a crucial role in sustaining primary productivity within terrestrial ecosystems (Darwin et al., 

2009) and represents the portion of the Earth's surface not covered by water. As a fundamental 

geographic resource, land serves as a primary means of livelihood and economic activity. 

 

Throughout history, land has been a key factor in production and closely linked to economic growth 

(Toppr, 2023). Its control and utilization often lead to significant human interactions, shaping 

societies and economies. Human activities that alter or maintain land cover attributes directly 

contribute to land use changes. These changes range from the conversion of natural forests into 

agricultural land to continuous grassland management practices (Jarraud & Steiner, 2012). 

 

2.2 OVERVIEW OF LAND USE LAND COVER 

 

Land use and land cover are crucial elements influencing global ecosystems, including climate, sea 

levels, and atmospheric conditions. Their accurate assessment is essential for policymaking, 

environmental management, and spatial planning (Sharma et al., 2019). Land use refers to the 

purpose for which humans utilize land, while land cover describes its physical characteristics, such 

as vegetation, soil, and water (Debie et al., 2008). Understanding these aspects is vital for sustainable 

development, as they directly impact biodiversity, climate change, and disaster vulnerability. 

 

Human activities significantly alter land cover, from deforestation to urban expansion, leading to 

environmental and socio-economic consequences (Kumar et al., 2014). Distinguishing between land 

use and land cover can be complex due to their interwoven nature, as changes in one often influence 

the other (Mahesh et al., 2023). Geospatial techniques, particularly remote sensing and 
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GIS, provide cost-effective and accurate methods for monitoring these dynamics, aiding decision- 

making in areas such as agriculture, forestry, urban planning, and resource management (Coppin & 

Bauer, 2017). 

 

Rapid population growth and increasing demands exert pressure on land resources, resulting in 

unplanned changes that contribute to global warming, habitat loss, and natural disasters (Seto, 2011; 

Prenzel, 2012). Remote sensing imagery, including multispectral classification methods, enhances 

the ability to monitor these shifts, offering valuable insights for environmental conservation and 

economic planning (Alakpodia, 2014). The availability of satellite data facilitates real-time 

observation of land changes, enabling governments and organizations to implement effective land-

use policies. 

 

Accurate land-use classification supports environmental modeling, including climate change 

projections and policy development (Disperati et al., 2015). Satellite-based classifications, such as 

supervised and unsupervised techniques, provide critical data for Geographic Information Systems 

(GIS), informing resource allocation and future land-use planning (Lillesand & Kiefer, 2011). The 

interdependence of land use and land cover means that while modifications in one do not necessarily 

indicate degradation, their shifts significantly influence biodiversity, water cycles, and atmospheric 

conditions (Riebsame et al., 2015). 

 

Environmental factors, such as soil characteristics, climate fluctuations, and topography, dictate 

land-use patterns, while human interventions, including agriculture, industrial expansion, and 

infrastructure development, drive land-cover transformations (Moshen, 2011). Advances in remote 

sensing techniques have demonstrated their superiority over traditional field surveys, enhancing 

vegetation analysis and facilitating comprehensive land assessments (Ko et al., 2017; Reinke & 

Jones, 2006). This ability to monitor and predict land-use trends is critical for sustainable land 

management and future planning efforts. 
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2.3 REMOTE SENSING IN LULC 

 

Historically, aerial photographs have served as a valuable source of land cover and land use 

information. However, their acquisition and interpretation are often costly, especially for large 

geographic areas. In response, recent advancements have explored more cost-effective alternatives, 

including Unmanned Aerial Vehicles (UAVs) and advanced image classification techniques. Studies 

such as Detsikas et al. (2024) highlight the integration of low-cost UAV imagery with machine 

learning classifiers, demonstrating its potential for accurate mapping while significantly reducing 

costs. 

 

A practical alternative to aerial photography is the use of digital satellite imagery, such as Landsat TM 

and ETM+. The open-access policy of Landsat data has greatly benefited both operational 

applications and scientific research by minimizing the expense associated with land cover mapping 

(Zhu et al., 2019). Additionally, improvements in classification methods have enhanced the 

efficiency and accuracy of land cover maps derived from Landsat imagery (Gašparović et al., 2019). 

 

Advancements in space technology have further facilitated the production of high-resolution satellite 

images such as SPOT 5, IKONOS, QuickBird, and OrbView-3, with ground sampling distances 

(GSD) ranging from 10 meters to 1 meter. These improvements have strengthened image 

classification and resource monitoring capabilities, supporting applications in change detection and 

early warning systems. Enhanced spatial resolution has made satellite imagery more applicable at 

global, regional, and local levels, enabling precise land cover classification. 

 

The Sentinel-2 mission, with its 10-meter resolution, supports environmental monitoring and urban 

planning (Drusch et al., 2012), while radar-based satellites like TerraSAR-X provide high- resolution 

imagery for topographic mapping and land use assessments (Krieger et al., 2013). The United States 

Geological Survey (USGS) plays a crucial role in making satellite data, such as Landsat imagery, 

freely available, facilitating long-term monitoring and analysis. 
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Satellite imagery enables the direct observation of land surfaces at regular intervals, allowing for 

effective mapping and monitoring of land use dynamics. Classification methods utilizing optical 

remote sensing help assess the accuracy of multi-temporal classification and detect urban growth 

patterns. Remote sensing technology offers planners and resource managers a reliable mechanism to 

monitor land use changes efficiently, providing updated land cover information in a cost- effective 

and timely manner (Lillesand & Kiefer, 2011). 

 

The introduction of remote sensing systems and image processing software has significantly 

expanded the importance of Geospatial Information Systems (GIS) (Merchant & Narumalani, 2009). 

Remote sensing has proven instrumental in measuring both qualitative and quantitative terrestrial 

land cover changes (Lillesand & Kiefer, 2011). While qualitative changes result from natural or 

human-induced phenomena, quantitative land cover transformations such as those caused by fires or 

storms can be effectively monitored through satellite imagery. 

 

Satellite remote sensing techniques offer significant advantages over conventional land-use mapping 

methods, which are labor-intensive, time-consuming, and require substantial personnel. Traditional 

maps quickly become outdated, are difficult to revise, and often necessitate complete reproduction 

for updates. Time-series analysis and monitoring changes can also be challenging with traditional 

surveying methods. In contrast, satellite-based remote sensing has emerged as the most efficient way 

to monitor land use changes at regular intervals. For inaccessible regions, remote sensing remains 

the primary method of acquiring reliable land-use data efficiently and cost-effectively. 
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2.3.1 Sentinel-2 Imagery in LULC Studies 

 

Sentinel-2 imagery has proven invaluable in Land Use and Land Cover (LULC) studies due to its 

high spatial resolution and frequent revisit cycles. Launched by the European Space Agency (ESA) 

in 2017, Sentinel-2 provides multispectral data at resolutions of 10m, 20m, and 60m, enabling 

detailed analysis of vegetation, water bodies, urban expansion, and land degradation (Drusch et al., 

2012). 

 

Studies such as Gašparović et al. (2019) have highlighted the effectiveness of Sentinel-2 in change 

detection and land classification, particularly in urban and agricultural monitoring. Zhu et al. (2019) 

emphasized the advantage of its free-access policy, making high-quality satellite imagery readily 

available for operational and scientific applications. Additionally, Krieger et al. (2013) explored its 

integration with radar-based observations for enhanced topographic mapping. 

 

Sentinel-2 imagery, combined with Geographic Information Systems (GIS), supports policymakers 

in making informed decisions regarding sustainable land management. Its multi- temporal 

capabilities enable tracking of land-use dynamics, which is particularly useful for regions like Delta 

State, where rapid urbanization and industrial activities significantly influence environmental 

patterns 

 

2.4 GEOGRAPHIC INFORMATION SYSTEM (GIS) IN LAND COVER ANALYSIS 

 

The definition of Geographic Information Systems (GIS) has been a subject of debate, with 

discussions on whether it should be framed narrowly in technological terms or viewed from a broader 

organizational perspective (Maguire, 2002). However, Burrough (1986) provides a widely accepted 

definition, describing GIS as a combination of tools for collecting, storing, retrieving, modifying, 

and displaying geographical data from the real world. 



11  

In his study, Ejemeyovwi (2015) utilized remote sensing to develop and acquire land use and land 

cover (LULC) data in Asaba, Delta State, Nigeria. His research employed satellite imagery verified 

through fieldwork to analyze LULC changes between 1996 and 2015. By integrating GIS and remote 

sensing, he examined the role of these technologies in mapping LULC patterns across the Niger 

Delta region. Using NARSDA satellite images, he conducted ground validation to ensure data 

accuracy and incorporated the digital satellite data into IDRISI 32 GIS software for classification 

and analysis. 

 

His study identified five distinct LULC categories: farmland, built-up areas, wasteland, forest land, 

and water bodies. The findings showed significant spatial expansion in Asaba, particularly between 

1996 and 2006, with even higher urban growth from 2006 to 2015. Land absorption coefficients, 

which measure the rate of urban land consumption due to population increase, were notably high 

during both periods. His research also revealed a decline in forested areas, agricultural land, and 

open spaces, attributed to anthropogenic activities such as farming, bush burning, and grazing, 

while water bodies remained largely unchanged. 

 

Ejemeyovwi's study highlights the efficiency of GIS and remote sensing in land use mapping 

compared to traditional methods. His research demonstrates the benefits of satellite-based LULC 

analysis for urban planning and environmental management in the Niger Delta region. 

 

2.4.1 Data Integration of GIS in LULC 

 

GIS enables the integration of diverse datasets, including satellite imagery, topographic maps, 

demographic information, and socio-economic indicators. This multi-layered approach is essential 

for understanding the complex factors driving land use and land cover (LULC) changes. For 

example, Adepoju (2017) demonstrated the effectiveness of GIS in combining Landsat imagery 

with population density data to analyze urban expansion patterns, highlighting the strong correlation 

between population growth and increased built-up areas. 
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Efficient data management within GIS ensures the storage, retrieval, and manipulation of spatial 

information, allowing for comprehensive analysis. According to Longley et al. (2015), GIS 

databases handle large volumes of spatial data, facilitating detailed temporal and spatial 

assessments crucial for monitoring LULC changes over time. 

 

2.4.2 Spatial Analysis Techniques 

 

GIS provides a range of spatial analysis tools that are crucial for examining Land Use and Land 

Cover (LULC) changes. These tools help in identifying trends, relationships, and patterns in land 

transformation, supporting sustainable planning and resource management. 

 

i. Overlay Analysis: This technique combines multiple spatial datasets to detect and analyze trends 

in LULC changes. Comparing satellite images from different years allows for the identification of 

urban expansion, land reclamation, and shifts in agricultural land use (Bai et al., 2023). 

ii. Buffer Analysis: Buffer zones are created around specific features like roads or water bodies to 

assess their impact on surrounding land use. Studies indicate that this method is effective in 

analyzing urban sprawl and identifying areas in need of green space conservation (Wolch et al., 

2014). 

iii.  Proximity Analysis: This tool evaluates the spatial relationship between various land cover types 

and infrastructure. Ogundele et al. (2011) applied proximity analysis to examine how the distance 

from urban centers influences land conversion, particularly from agricultural to residential use. 

iv.  Hotspot Detection: GIS-based hotspot analysis pinpoints regions undergoing significant LULC 

changes, allowing for targeted investigations and policy interventions. Balogun et al. (2011) used 

this approach to identify rapidly urbanizing areas, aiding in strategic urban planning. 
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2.4.3 Change Detection and Temporal Analysis 

 

i. GIS plays a crucial role in change detection methodologies, enabling the comparison of spatial 

data from different time periods to identify and quantify Land Use and Land Cover (LULC) 

changes. The implementation of GIS in change detection is essential for understanding current 

trends and forecasting future land use patterns. Yuan et al. (2005) demonstrated the 

effectiveness of this approach in their study on urban expansion in the Twin Cities, Minnesota, 

using GIS to analyze LULC changes across various time intervals. By identifying shifts in land 

cover types, such as the transition from vegetation to built-up areas, they provided insights into 

the rate and direction of urbanization. 

ii. Similar techniques have been applied in Delta State, where GIS-based change detection has 

revealed significant conversions of agricultural land into residential and commercial areas over 

the past two decades. Effective handling of raster data allows for the comparison of satellite 

images across different dates. Faisal Koko et al. (2021) utilized GIS to analyze Landsat imagery, 

detecting urban expansion and highlighting the utility of raster-based techniques in large-scale 

LULC studies. Additionally, GIS can process vector data, such as land parcel boundaries, to 

monitor finer-scale land use changes. Grochala and Kedzierski (2017) employed vector-based 

change detection to examine shifts in land ownership and usage patterns, providing insights into 

the socio-economic drivers of LULC changes. 

 

 

 

2.4.4 Visualization and Mapping 

 

One of the most significant advantages of GIS is its ability to generate detailed and insightful 

visualizations that effectively communicate complex spatial data. High-quality maps and 

interactive visual tools play a crucial role in conveying Land Use and Land Cover (LULC) analysis 

results to policymakers, planners, and the public. GIS facilitates the creation of thematic 
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maps that highlight specific LULC changes, such as deforestation, urban expansion, and shifts in 

agricultural land use. 

 

Adepoju et al. (2006) employed thematic mapping to illustrate the spatial distribution of land cover 

types in Delta State, enabling the identification of key areas undergoing environmental 

transformation. Olayinka et al. (2019) utilized 3D GIS visualization to assess the impact of urban 

growth on flood-prone zones, improving the precision of flood risk assessments. 

 

The development of web-based GIS applications has enhanced the accessibility and usability of 

spatial data, allowing for real-time data sharing and collaborative analysis among stakeholders. 

Adepoju (2017) introduced an interactive web GIS tool for stakeholders in Delta State, enabling 

them to monitor LULC changes and actively engage in urban planning processes. These 

advancements in GIS technology support informed decision-making and sustainable land 

management in rapidly developing regions. 

 

2.4.5 Decision Support Systems (DSS) 

 

Geographic Information Systems (GIS) play a crucial role within Decision Support Systems 

(DSS), integrating spatial data with analytical models to facilitate informed decision-making. This 

approach ensures that Land Use and Land Cover (LULC) changes are managed effectively and 

sustainably. 

 

Ndehedehe et al. (2013) employed a GIS-based DSS to develop land use zoning regulations, aimed 

at curbing urban sprawl and preserving essential green spaces. Similarly, Gebre samuel et al. 

(2010) highlighted the importance of GIS-based DSS in assessing the environmental impact of land 

use changes, particularly in relation to soil degradation and surface runoff. Their findings 

contributed to the implementation of effective soil conservation strategies. 
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By leveraging GIS within DSS frameworks, planners and environmental managers can better 

analyze spatial trends, optimize resource allocation, and develop policies that promote sustainable 

urban development and environmental protection. 

 

2.4.6 A Review of GIS Applications in LULC 

 

2.4.6.1 Urban Sprawl Analysis 

 

Urban sprawl is a growing challenge in Delta State, driven by population growth, economic 

activities, and rural-to-urban migration. The expansion of built-up areas has led to the 

encroachment of agricultural land, wetlands, and green spaces, resulting in environmental 

degradation and increased pressure on infrastructure. Geographic Information Systems (GIS) and 

remote sensing play a vital role in assessing and monitoring these changes, providing essential 

insights for urban planning and sustainable land management. 

 

Ejemeyovwi (2015) conducted a GIS-based study on urban growth in Delta State, utilizing remote 

sensing techniques and spatial analysis to examine land use changes over time. His research 

revealed significant expansion of built-up areas between 1996 and 2015, with projections 

indicating continued urbanization at the expense of agricultural and forested lands. This expansion 

has contributed to reduced vegetation cover, soil depletion, and heightened vulnerability to 

flooding, emphasizing the need for strategic land use policies. 

 

By analyzing historical and projected land use patterns, the study demonstrated how GIS-based 

models can support decision-making processes aimed at mitigating urban sprawl. The findings 

highlight the urgency of adopting proactive urban planning strategies that integrate sustainable 

land management, green space preservation, and improved infrastructure planning in Delta State. 
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2.4.6.2 Wetland Conservation 

 

Delta State's wetland ecosystems play a crucial role in flood control, biodiversity conservation, 

and water purification. However, rapid urbanization has increasingly threatened these fragile 

environments. Ejemeyovwi (2015) applied GIS to analyze the encroachment of urban areas into 

Delta State’s wetlands using historical satellite imagery and spatial analysis tools. His study 

identified critical zones where wetlands were being converted into residential and industrial land 

uses, emphasizing the need for stronger land use policies to prevent degradation. 

 

Additionally, Adepoju (2017) conducted a GIS-based assessment of wetland loss in Delta State, 

highlighting the importance of regular monitoring for effective conservation strategies. His 

findings reinforced the urgency of protecting wetlands through sustainable land-use planning and 

stricter regulatory frameworks. These studies offer valuable insights for policymakers and urban 

planners, underscoring the need for proactive environmental management in Delta State. 

 

2.4.6.3 Flood Risk Mapping 

 

Flooding is one of the most persistent challenges in Delta State due to its geographical features 

and frequent heavy rainfall. The integration of Geographic Information Systems (GIS) and remote 

sensing has enabled the creation of flood risk maps, providing crucial information for disaster 

preparedness and mitigation efforts. 

 

Ejemeyovwi (2015) conducted a GIS-based study on flood risk mapping in Delta State, utilizing 

Digital Elevation Models (DEMs) and rainfall data to identify flood-prone areas. His study 

highlighted key vulnerable zones, particularly in regions with poor drainage infrastructure and 

high population densities. These GIS generated maps have supported the implementation of 

targeted flood mitigation measures, including improved drainage systems, early warning alerts, 

and the strategic relocation of residents in high-risk areas. 
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Adepoju (2017) further advanced GIS applications in flood prediction by integrating hydrological 

modeling techniques. His research demonstrated that incorporating GIS and remote sensing tools 

into urban planning could significantly reduce disaster-related losses, reinforcing the need for 

proactive flood management strategies in Delta State. 

 

2.4.6.4 Green Space Monitoring 

 

The reduction of green spaces in Delta State due to urbanization and population growth has become 

a significant concern for environmental sustainability. Green spaces, including parks, gardens, and 

forest reserves, provide crucial ecological benefits such as air purification, temperature regulation, 

and recreational areas for residents. Ejemeyovwi (2015) applied remote sensing and Geographic 

Information System (GIS) techniques to monitor the loss of green spaces in Delta State, linking it 

to increased urban expansion and industrial activities. 

 

2.4.6.5 Environmental Impact Assessments 

 

GIS has been widely applied in conducting Environmental Impact Assessments (EIA) in Delta 

State. By integrating land cover maps with demographic, industrial, and pollution data, researchers 

can evaluate the environmental consequences of urban expansion and industrial activities. 

Ejemeyovwi (2015) utilized GIS to assess the environmental impacts of industrialization in Delta 

State, identifying significant land degradation, vegetation loss, and increased pollution levels due 

to rapid industrial growth. His study emphasized the need for mitigation strategies, including 

reforestation programs and stricter pollution control policies, to preserve ecological balance. 

Adepoju (2017) further demonstrated the effectiveness of GIS-based assessments in environmental 

management, reinforcing the importance of spatial analysis in guiding sustainable development 

policies. These studies highlight the role of GIS in supporting informed decision-making for 

environmental conservation in Delta State. 
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2.5 METHODOLOGIES FOR LULC ANALYSIS 

 

Land Use Land Cover (LULC) analysis relies on advanced methodologies to monitor, assess, and 

detect changes over time. These approaches involve satellite image classification and change 

detection techniques, providing a comprehensive understanding of spatial and temporal land cover 

transformations. Sentinel-2 imagery, with its multi-spectral and high-resolution capabilities, is 

widely used in LULC studies. Its frequent revisit cycles and diverse spectral bands enable precise 

classification and change detection, supporting informed decision-making in land management 

and environmental planning. 

 

2.5.1 Image Classification Techniques 

 

Image classification is a crucial process in Land Use and Land Cover (LULC) analysis, where 

satellite images are categorized into distinct land cover types, including forests, urban areas, water 

bodies, and agricultural lands. This technique assigns image pixels to predefined classes based on 

their spectral properties, enabling accurate land cover mapping. The two primary approaches used 

in image classification are supervised and unsupervised classification, each offering distinct 

methodologies for analyzing satellite imagery. 

i. Supervised Classification: This technique requires prior knowledge of the study area and 

relies on training data to classify pixels. The analyst selects representative training areas of 

known land cover types, which the classification algorithm then uses to identify similar 

spectral characteristics across the image (Campbell & Wynne, 2011). The Maximum 

Likelihood Classification (MLC) method is widely used, assuming a normal distribution of 

class statistics within each spectral band (Richards & Jia, 2006). Supervised classification is 

preferred when sufficient training data are available, as it generally provides higher accuracy. 
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ii. Unsupervised Classification: Unlike supervised classification, this approach does not require 

pre-labeled training data. Instead, it relies on clustering algorithms, such as K-means and 

ISODATA, to group pixels into clusters based on spectral similarities (Foody, 2002). 

Unsupervised classification is useful when prior knowledge is limited or when working with 

complex landscapes that contain multiple land cover types. However, its accuracy depends on 

how well these clusters correspond to real-world land cover categories (Lillesand et al., 2015). 

iii. Object-Based Image Analysis (OBIA): OBIA is an advanced classification technique that 

segments pixels into meaningful objects or groups based on spatial, spectral, and textural 

properties. This method improves classification accuracy, particularly in heterogeneous 

landscapes (Blaschke, 2010). Unlike pixel-based approaches, OBIA considers the shape, size, 

and contextual relationships of objects, making it highly effective for analyzing high- 

resolution satellite imagery. 

 

 

2.5.2 Change Detection Methods 

 

Change detection is a crucial technique in Land Use and Land Cover (LULC) analysis, enabling 

the identification and measurement of changes over time by comparing satellite images from 

different periods. Various change detection methods have been developed, each offering distinct 

advantages and limitations based on the nature of the analysis and research objectives. Some of 

the most widely used approaches include: 

 

2.5.2.1 Post-Classification Comparison 

 

Post-classification comparison is a widely used method for detecting Land Use and Land Cover 

(LULC) changes, involving pixel-by-pixel comparison of classified images from different time 

periods (Singh, 1989). This technique requires independent classification of both images before 

conducting change detection analysis. While computationally demanding and reliant on 

classification accuracy, it proves highly effective for detailed assessments, particularly in regions 
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experiencing significant land use transformation (Lu et al., 2004). It enables precise identification 

of changes, such as the conversion of forested areas into urban developments or agricultural lands 

into built-up zones. 

 

2.5.2.2 Image Differencing 

 

Image differencing is a widely used change detection method that highlights variations in pixel 

values by subtracting two co-registered satellite images from different time periods. This 

straightforward technique effectively identifies significant spectral changes, often associated with 

deforestation, urbanization, or vegetation loss (Coppin et al., 2004). It is particularly useful for 

detecting abrupt land cover changes over short periods, making it a valuable tool in vegetation 

studies. 

 

The process involves selecting two satellite images captured at different dates and subtracting their 

pixel values to generate a difference image. Areas that remain unchanged exhibit low pixel value 

differences, while regions undergoing transformation display higher differences, indicating notable 

spectral variations. Image differencing operates on the assumption that substantial pixel value 

changes correspond to land cover modifications caused by urban expansion, agricultural 

development, or environmental factors such as forest degradation and flooding. 

 

In vegetation analysis, the near-infrared (NIR) and red spectral bands are commonly used due to 

their sensitivity to vegetation properties. By subtracting the NIR band of an earlier image from that 

of a later image, areas experiencing vegetation growth or decline can be effectively identified. This 

method is particularly advantageous in landscapes where vegetation is a dominant feature, offering 

critical insights into environmental changes over time (Jensen, 2007). 
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CHAPTER THREE 

METHODOLOGY 

 
3.1 DESCRIPTION OF THE STUDY AREA 

 

Delta State is one of the oil-rich states in Nigeria, situated in the South-South region of the country. 

It shares boundaries with Edo State to the north, Anambra and Rivers States to the east, Bayelsa 

State to the southeast, and the Bight of Benin to the south and west. The state lies approximately 

between latitudes 5°00’N and 6°45’N, and longitudes 5°00’E and 6°45’E. One of the state’s 

defining geographical features is the River Niger, which flows through and divides it into distinct 

ecological zones. These zones include mangrove swamps, freshwater wetlands, and uplands. 

 

Delta State is divided into three senatorial zones, namely Delta North, Delta Central, and Delta 

South, with a total of 25 Local Government Areas. The state capital is Asaba, located in the 

northern part of the state, while Warri, a key commercial city, plays a central role in the oil and gas 

industry. These LGAs form the backbone of local governance and administration, helping to 

promote development across rural and urban communities. 

 

The state, like many others, is confronted with a range of socio-economic and environmental 

challenges. Issues such as inadequate infrastructure, pollution resulting from oil exploration and 

gas flaring, poor land administration, and limited access to quality education and healthcare 

services continue to hinder its development. Youth unemployment, poverty, and internal conflicts 

also pose threats to the peace and progress of communities. In response to these challenges, 

collaborative efforts are being made by government agencies, community-based organizations, and 

civil society to improve service delivery, promote peacebuilding, and encourage sustainable 

development initiatives throughout the state. 

 

 

 



22  

 

 
Figure 3.1.1: Map of the Study Area 
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3.2 DATA SOURCE 

 

The satellite images that were used were obtained from the ESRI Sentinel-2 Explorer, a platform 

that provides free access to high-resolution, multispectral satellite imagery for environmental 

monitoring and analysis. Sentinel-2 is part of the European Space Agency’s Copernicus Programme 

and consists of a constellation of two satellites Sentinel-2A and Sentinel-2B which provide global 

coverage of land surfaces every five days. These satellites are equipped with multispectral sensors 

that capture data in 13 spectral bands at spatial resolutions of 10 m, 20 m, and 60 m, making them 

suitable for land use and land cover (LULC) analysis, vegetation monitoring, and change detection. 

 

The Sentinel-2 mission began in 2015, with Sentinel-2A launched in June 2015 and Sentinel-2B in 

March 2017. The imagery used for this study was obtained from the Sentinel-2 Level-2A product, 

which provides atmospherically corrected surface reflectance data. These images are accessible 

through the ArcGIS Living Atlas and can be explored using the Sentinel-2 Explorer application 

developed by ESRI. The Sentinel-2 data offers improved spatial and spectral resolution compared 

to earlier missions, allowing for more detailed and accurate classification of land cover types. 

 

Due to the availability of Sentinel-2 data from mid-2015 to the present, the analysis period was 

limited to approximately six years. A total of two datasets were obtained for the LULC analysis, 

each representing different time epochs within the six-year period. These datasets were used to 

assess changes in land cover and to enhance the accuracy of classification through temporal 

comparison and spectral analysis. 
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3.3 MATERIALS 

 

For this study, a range of software applications was employed for data collection, processing, 

analysis, and presentation. 

 

1. ArcGIS 10.8: This software was employed for image preprocessing tasks, including 

atmospheric and radiometric corrections, supervised and unsupervised image classification, and 

change detection analysis. 

2. Google Earth Pro: Used to access base imagery for data validation and to extract features of 

interest within the study area. 

3. Microsoft Excel 2013: Pivot tables in Excel were used to generate the transition matrices for 

each year, aiding in the analysis of land cover changes over time. 

4. QGIS: This open-source GIS software was utilized to generate the projected 2030 land use/land 

cover map. Its advanced spatial modeling tools and plugins, such as MOLUSCE, were 

instrumental in simulating future land cover scenarios and refining classification outputs. 

 

3.4 IMAGE ACQUISITION 

 

The satellite images used for this study were obtained from the ESRI ArcGIS platform, specifically 

through the Sentinel-2 Land Cover Explorer. This platform provides free access to high-resolution, 

multispectral imagery derived from the Sentinel-2 satellite constellation, which is part of the 

European Space Agency’s Copernicus Programme. Sentinel-2 consists of two satellites; Sentinel-

2A and Sentinel-2B equipped with multispectral sensors that capture data across 13 spectral bands 

at spatial resolutions of 10m, 20m, and 60m. These features make Sentinel-2 imagery highly suitable 

for land use and land cover (LULC) analysis, vegetation monitoring, and environmental change 

detection. 

 

The Sentinel-2 mission began in 2015, with Sentinel-2A launched in June 2015 and Sentinel-2B in 

March 2017. For this study, satellite images from the years 2018 and 2024 were specifically 
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selected to assess changes in land cover over a six-year period. These images were sourced from 

the Sentinel-2 Level-2A product, which provides atmospherically corrected surface reflectance 

data, ensuring improved accuracy in classification and analysis. 

 

To maintain consistency and minimize atmospheric interference, only images with less than 10% 

cloud cover were selected over the study area during relatively clear days. The selected datasets 

from 2018 and 2024 were used to perform a comparative LULC analysis, enabling the identification 

of spatial and temporal changes in land cover patterns. The high spatial resolution and temporal 

frequency of Sentinel-2 imagery contributed significantly to the reliability and precision of the 

classification results. 

 

3.5 PREDICTION ANALYSIS 

 

To predict land use and land cover (LULC) for the year 2030, a modeling approach was applied 

using the classified Sentinel-2 images from 2018, 2021 and 2024 as input datasets. The prediction 

was carried out using the MOLUSCE (Modules for Land Use Change Simulation) plugin in QGIS, 

which integrates cellular automata, Markov Chain analysis, and machine learning algorithms to 

simulate future land cover scenarios based on historical trends and transition probabilities. 

 

The process involved the following key steps: 

 

 

i. Input Preparation: The classified maps from 2018, 2021 and 2024 were used to calculate 

transition probabilities between land cover classes. These probabilities reflect the likelihood of 

one land cover type changing into another over time. 

ii. Driving Factors: Spatial variables such as proximity to roads, elevation, slope, and population 

slope were incorporated as driving factors to influence the spatial distribution of future changes. 
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iii. Model Calibration: The model was trained using the 2018–2021 and  2021-2024   data to 

understand the dynamics of land transformation. The Markov Chain component estimated the 

statistical likelihood of class transitions, while the cellular automata simulated the spatial 

patterns of change. 

iv.  Prediction Output: The model projected the LULC map for 2030, highlighting areas expected 

to undergo significant transformation. The results indicated continued urban expansion, 

particularly in areas previously classified as vegetation and cultivated land. Vegetation cover 

showed a moderate decline, while built-up areas increased, reflecting ongoing urbanization 

trends. 

v. Validation: Though 2030 is a future year, the model’s reliability was assessed by comparing its 

2024 prediction (generated using 2018 data) with the actual 2024 classification. A high degree 

of similarity validated the model’s predictive strength. 

 

This predictive analysis provides valuable insights for urban planning, environmental management, 

and policy formulation 

 

3.6 IMAGE PRE-PROCESSING 

 
This consists of the various processes applied to the acquired Sentinel-2 imagery from 2018, 2021, 2024 and 

2030. The preprocessing techniques involved include geometric correction to align the imagery accurately 

with real-world coordinates, and band resampling to ensure uniform spatial resolution across all spectral 

bands. Additional steps included layer stacking to combine the multispectral bands into a single composite 

image, cloud masking to eliminate cloud-contaminated pixels using the Scene Classification Layer (SCL), 

and image clipping to extract only the area of interest from the full scene. These procedures ensured that the 

imagery was optimized for accurate land use and land cover analysis across the two time periods. 
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3.6.1 Layer stacking 

 

This process, commonly referred to as band combination, was applied to Sentinel-2 satellite 

imagery to generate a composite multiband raster layer for Land Use and Land Cover (LULC) 

analysis. For Sentinel-2, the bands used for a natural color composite are Band 4 (Red), Band 3 

(Green), and Band 2 (Blue), all of which have a spatial resolution of 10 meters. This combination 

enhances visual interpretation by leveraging color, tone, texture, and spatial association to 

distinguish between different land cover features. 

 

The procedure using ArcMap 10.8 is as follows: 

 

 

i. From the menu bar, select Windows. 

 

ii. Under the Windows tab, open the Image Analysis tools. 

 

iii. In the Image Analysis window, highlight Bands 4, 3, and 2 of the Sentinel-2 imagery. Then 

click the Composite Bands tool to generate a temporary multiband raster layer. 

iv. In the Display panel of the Image Analysis dialog box, adjust the brightness, contrast, and 

transparency settings to enhance the visual quality of the composite image. 

v. Assign an output filename and choose the output file format (e.g., .tif). Click Save to export 

the composite raster to your desired directory. 

 

3.6.2 Mosaicking 

 

The multiband raster layers generated from the Sentinel-2 imagery for the years 2018 and 2024 

were merged to streamline the clipping and analysis process. The steps for mosaicking these scenes 

using ArcMap 10.8 are outlined below: 

 

i. The Mosaic to New Raster tool was accessed via ArcToolbox > Data Management Tools > 

Raster > Raster Dataset > Mosaic to New Raster. 
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ii. In the dialog box that appeared, the stacked Sentinel-2 images were added to the Input Rasters 

field. The order of the images was adjusted as needed to ensure proper alignment and continuity. 

iii. The Output Location was specified, and a suitable filename and the number of bands (typically 3 

for RGB composites or more for full multispectral stacks) were entered. The appropriate pixel 

type and spatial reference were also selected. 

iv. The OK button was clicked to initiate the mosaicking process, resulting in a single, seamless 

multiband raster dataset that could be easily clipped to the study area and used for further LULC 

analysis. 

 

3.6.3 Clipping Study Area 

 

The multiband raster layers generated from the Sentinel-2 imagery for the years 2018 and 2024 for 

Delta state were merged to streamline the clipping and analysis process. The steps for mosaicking 

these scenes using ArcMap 10.8 are outlined below: 

 

i.     The Mosaic to New Raster tool was accessed via ArcToolbox > Data Management Tools > 

Raster > Raster Dataset > Mosaic to New Raster. 

ii. In the dialog box that appeared, the stacked Sentinel-2 images were added to the Input Rasters 

field. The order of the images was adjusted as needed to ensure proper alignment and 

continuity. 

iii. The Output Location was specified, and a suitable filename and the number of bands (typically 

3 for RGB composites or more for full multispectral stacks) were entered. The appropriate 

pixel type and spatial reference were also selected. 

iv. The OK button was clicked to initiate the mosaicking process, resulting in a single, seamless 

multiband raster dataset that could be easily clipped to the study area(Delta State) and used for 

further LULC analysis. 
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3.4 IMAGE CLASSIFICATION 

 

This process involves classifying Sentinel-2 satellite imagery into distinct land cover categories 

such as built-up areas, vegetation, water bodies, and bare land. Both supervised and unsupervised 

classification techniques will be employed to enhance the accuracy and reliability of the results. 

 

3.4.1 Unsupervised Classification 

 

Unsupervised classification techniques, such as ISODATA (Iterative Self-Organizing Data 

Analysis Technique), were applied to the Sentinel-2 imagery to group pixels into spectral clusters 

without prior knowledge of land cover types. This approach was particularly useful for identifying 

dominant land cover classes in the study area. The procedure using ArcGIS is as follows: 

 

i. Launch ArcGIS software and import the preprocessed and stacked Sentinel-2 raster data. Set 

the appropriate coordinate system for the study area. 

ii. Navigate to Customize > Toolbars > Image Classification and activate the Image Classification 

toolbar. 

iii. From the toolbar, select Iso Cluster Unsupervised Classification. In the dialog box, choose the 

stacked Sentinel-2 raster as the input and specify the desired number of classes. For this study, 

six classes were used to represent the major land cover types. 

iv. Define the output location and filename for the classified raster, then click OK to execute the 

classification process 

 

3.4.2 Supervised Classification 

 

For more accurate classification of the Sentinel-2 imagery, a supervised classification technique 

was employed using representative training data. Known land cover types namely Built-up areas, 

Vegetation, Water bodies, Bare land, and Cultivated land were manually identified and used as 

training samples. These samples were selected based on their spectral characteristics and 
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visual interpretation, aided by high-resolution World Imagery in ArcGIS and Google Earth for 

reference. 

 

i. The Maximum Likelihood Classifier (MLC) was then applied to assign each pixel to the most 

probable land cover class based on its spectral signature. MLC assumes that the statistics for 

each class in each band are normally distributed and calculates the probability of a pixel 

belonging to a particular class. The pixel is then assigned to the class with the highest 

probability. 

ii. To collect training samples, the Circle tool under the Training Sample Manager in ArcMap was 

used to delineate homogeneous areas of similar pixel color and texture. These samples were 

used to train the classifier, ensuring that each land cover category was well represented across 

the study area. 

 

 
             Figure 3.2: Training Sample Class for Supervised Classification 

 

3.4.3 Accuracy Assessment 

 

An accuracy assessment was carried out to evaluate the reliability of the classified Sentinel-2 land 

cover maps. This involved generating a confusion matrix by comparing classified pixel values with 

reference data obtained from Google Earth Pro. The assessment included the calculation of 
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overall accuracy, producer’s accuracy, user’s accuracy, and the Kappa coefficient, each of which 

provides insight into the classification’s performance and agreement with ground truth data. 

 

To begin, a point shapefile was created and used to select multiple sample points across the 

classified raster. The editing session was initiated using the “Start Editing” option on the Editor 

toolbar in ArcMap. Once the sample points were selected, they were exported to a KML file using 

the Spatial Analyst Tools > Conversion > Raster to KML function. 

 

The resulting KML file was opened in Google Earth Pro, where the time slider was used to navigate 

to the appropriate reference year 2018, 2021 and 2024 in this case. Each sample point was visually 

verified against high-resolution imagery, and the observed land cover type was recorded. This 

process was repeated for all selected years to ensure consistency and temporal accuracy. 

 

The collected data was then tabulated and used to populate the confusion matrix. From this matrix, 

the following accuracy metrics were computed: 

 

User Accuracy: 

(Correctly classified pixels in a category ÷ Total pixels classified in that category) × 100% 

 
Producer Accuracy: 

(Correctly classified pixels in a category ÷ Total reference pixels of that category) × 100% 
 

 
Overall Accuracy: 

(Total correctly classified pixels ÷ Total number of reference pixels) × 100% 
 

 
K = 

𝑃𝑜−𝑃𝑒 

               1−𝑃𝑒 Where: 

Po – the observed accuracy (sum of correctly classified pixels divided by total reference pixels), Pe – 

the expected accuracy (sum of the products of row and column totals for each class) 
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3.5 CHANGE DETECTION ANALYSIS 

 

To detect and quantify land use and land cover (LULC) changes over the study period, the 

classified Sentinel-2 images from 2018, 2021, 2024 and the predicted 2030 will be compared using 

post- classification change detection techniques. This method involves analyzing the differences 

between the classified maps from both years to identify transitions between land cover types such 

as conversions from dense vegetation to built-up areas or from cropland to bare soil. 

 

The process typically includes generating a change matrix (also known as a transition matrix), 

which tabulates the number of pixels that changed from one class to another. This matrix helps 

quantify the extent and direction of land cover changes, offering insights into patterns such as 

urban expansion, deforestation, or agricultural intensification. 

 

By comparing the spatial distribution and area coverage of each land cover class across the two 

time periods, the analysis provides a clear picture of how the landscape has evolved. These results 

can then be visualized using thematic maps, bar charts, or Sankey diagrams to communicate the 

dynamics of land transformation effectively. 

 

3.5.1 Post-Classification Comparison 

 

The primary method for change detection in this study is post-classification comparison, which 

involves overlaying the classified Sentinel-2 images from 2018, 2021, 2024 and 2030. This 

approach is preferred because it reduces the influence of atmospheric and sensor-related 

differences between acquisition dates. Changes in land cover categories such as transitions from 

vegetation to built-up areas or from water bodies to bare land will be identified and quantified 

using GIS tools like ArcGIS. The step-by-step procedure is as follows: 

 

i. Import the classified raster datasets for 2018, 2 0 2 1 ,  2024 and 2030 using the Add Data 

tool in ArcMap. 
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ii. Navigate to ArcToolbox > Conversion Tools > From Raster > Raster to Polygon. Select the 

classified raster as input and specify an output location and filename. 

iii. Right-click on the resulting polygon layer and select Open Attribute Table. 

 

iv. Go to Geoprocessing > Dissolve, choose the polygon layer as input, specify an output name, 

tick the Gridcode field, and click OK. 

v. In the attribute table of the dissolved polygon, add two new fields: one for the land cover class 

names (e.g., Vegetation, Bare land) and another for the area of each class. 

vi. Right-click the area field > Calculate Geometry, choose the preferred unit (e.g., hectares), and 

click OK. 

vii. Start an editing session using the Editor toolbar and manually assign class names to match the 

corresponding Gridcode values. 

viii. Repeat steps ii–vii for the second year (2021), third year (2024) and fourth year (2030) 

classified raster. 

 

ix. Navigate to Geoprocessing > Intersect, select the 2018 and 2021 dissolved polygons as inputs, 

specify an output file, and click OK. 

x. Open the attribute table of the intersected layer and add two new fields: one for area change 

and another for class change. 

xi. Right-click the area change field > Calculate Geometry, select the desired unit, and confirm. 

xii. Right-click the class change field > Field Calculator, and define the logic to capture 

transitions (e.g., from Dense vegetation to Built-up) based on the class fields from both years. 

 

3.5.1.1 Area Change Comparison 

 

The total area covered by each land cover class for the years 2018, 2021, 2024 and 2030 will be 

calculated and presented in a tabular format to illustrate the progression of land use over time. A 

corresponding graph will be generated to visually depict the increase or decrease in each class 

across the two years. The steps are as follows: 
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i. Open the dissolved polygon shapefile for each year in ArcGIS and access the attribute table. 

 

ii. Identify and copy the field containing the area values for each land cover class. 

 

iii.  Open a new Excel workbook and paste the area data into a worksheet, labeling each row with      

the corresponding land cover class. 

iv. Repeat the process for the second year and place the data side by side for comparison. 

 

v.    Calculate the total area for each year by summing the area values of all classes. 

 

 

Use the formula 

𝑇 = 𝐾⁄𝑁 

Where T= Percentage growth in LULC for a particular year 

 

K= Actual area covered by an individual class in the specified year N= Total area of the study area 

per year 

 

 

3.5.2 Confusion Matrix 

A confusion matrix is a table used to evaluate the performance of a classification model, especially 

in supervised classification. It compares the actual ground truth labels to the predicted labels made 

by the classifier. Rows represent the actual (reference) classes. Columns represent the predicted 

classes by the model.  Diagonal cells represent correct classification and Off-Diagonal cells 

represent misclassification 

 

 

 

 

 

3.6 Transition Matrix 

 

A transition matrix will be created to quantify the changes in land cover types between 2018, 2021, 

2024 and 2030. This matrix will detail how much land has shifted from one class to another such 

as from vegetation to built-up areas and will be visualized using maps and charts to highlight 

significant spatial transformations. 



35  

 

The steps are as follows: 

 

 

i. Open the attribute table of the intersected polygon layer in ArcGIS, which contains land cover 

information for both years and the corresponding area of each intersected class combination. 

ii.    Copy the relevant fields typically the land cover class for 2018, the class for 2021, and the 

area field and paste them into a new Excel spreadsheet. 

iii.   In Excel, go to the Insert tab and select PivotTable. 

iv.   In the PivotTable dialog box, assign the 2018 land cover class to the Rows, the 2021 land 

cover class to the Columns, and the area field to the Values section (set to "Sum"). Do same 

for 2024 to 2030 

v. Click OK to generate the matrix. The resulting table will display the total area that transitioned 

from each 2018 class to each 2021 class. Do same for 2021 to 2024 and  2024 to 2030 

 

3.7 DATA ANALYSIS AND VISUALIZATION 

The results derived from the post-classification comparison of the 2018, 2021, 2024 and 2030 

Sentinel- 2 imagery were used to generate charts and maps using ArcGIS and Microsoft Excel for 

a visual representation of the changes in pre-defined classes. These changes were analyzed to 

determine key trends in land cover change, such as the extent of urban expansion, loss of 

vegetation, and changes in water bodies. 
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CHAPTER FOUR 

PRESENTATION OF RESULTS 

4.1 Image Classification Results 

This classification and prediction were carried out using the Random Forest (RF) classifier within 

Google Earth Engine (GEE). The process involved the use of training samples representing five land-

cover classes: water body, dense vegetation, built-up, cropland, and bare soil. Sentinel-2 imagery for 

the years 2018, 2021, and 2024 was used to train the model and generate a predictive map for 2030. 

In 2018, dense vegetation dominated the landscape, particularly in the southern and central parts of 

the study area. Built-up regions were relatively limited, concentrated around major towns and 

transport corridors. Cropland was widely distributed, reflecting the region’s agricultural activity, 

while bare soil appeared in patches, mostly in transitional zones. Water bodies maintained consistent 

spatial coverage, primarily along rivers and wetlands. 

By 2021, built-up areas had expanded noticeably, encroaching into cropland and vegetated zones. 

This growth suggests increasing urbanization and infrastructure development. Dense vegetation 

showed signs of fragmentation, while cropland began to decline in some areas, possibly due to land 

conversion or changing farming practices. Bare soil increased slightly, likely due to construction and 

land clearing. Water bodies remained stable, with only minor seasonal fluctuations. 

The 2024 classification revealed a continued surge in built-up regions, with urban sprawl extending 

into previously undeveloped areas. Dense vegetation declined further, particularly near expanding 

urban zones. Cropland continued to shrink, and bare soil became more prominent, especially around 

construction sites and degraded lands. Water bodies showed minimal change, maintaining their 

spatial footprint. 
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The 2030 prediction projects significant changes in land cover. Built-up areas are expected to 

dominate the landscape, driven by population growth and economic development. Dense vegetation 

is predicted to decline further, raising concerns about habitat loss and reduced ecosystem services. 

Cropland is anticipated to decrease, especially near urban fringes, due to land conversion and reduced 

agricultural activity. Bare soil is expected to increase, reflecting ongoing development and land 

degradation. Water bodies are projected to remain relatively stable, with minor spatial variations 

linked to seasonal and hydrological factors. 

The Random Forest classifier in GEE effectively captured spatial patterns and temporal transitions, 

offering robust predictions for future land-cover dynamics. These insights are essential for guiding 

sustainable land-use planning and environmental management in Delta State. 

Below are the LULC maps of 2018, 2021, 2024, and 2030. 
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Figure 4.1.1: Delta State LULC map of 2018 
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Figure 4.1.2: Delta State LULC map of 2021 
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Figure 4.1.3: Delta State LULC map of 2024 
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Figure 4.1.4: LULC map of 2030 
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4.2 Results of Accuracy Assessment 

 

For the years 2018 and 2021, 2024 and 2030 the Producer accuracy, User accuracy, Kappa 

coefficient and Overall accuracy are shown below alongside their interpretations. 

Table 4.2.1: Confusion Matrix of Year 2018 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Total  

U 

 

Water Body  

 

3471 

 

0 

 

0 

 

0 

 

0 

 

3471 

 

Dense Vegetation  

 

0 

 

32779 

 

0 

 

1 

 

0 

 

32780 

 

Built-up 

 

0 

 

1 

 

19 

 

3 

 

1 

 

24 

 

Cropland 

 

0 

 

30 

 

0 

 

269 

 

4 

 

303 

 

Bare Soil 

 

0 

 

2 

 

0 

 

3 

 

45 

 

50 

 

Total P  

 

3471 

 

32812 

 

19 

 

276 

 

50 

 

36628 

 

 

Table 4.2.2: Confusion Matrix of Year 2021 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Total 

U 

 

Water Body  

 

3462 

 

0 

 

0 

 

0 

 

0 

 

3462 

 

 

Dense Vegetation  

 

0 

 

33063 

 

0 

 

3 

 

0 

 

33066 

 

Built-up 

 

0 

 

0 

 

23 

 

1 

 

0 

 

24 

 

Cropland 

 

0 

 

6 

 

0 

 

312 

 

1 

 

319 

 

Bare Soil 

 

0 

 

2 

 

1 

 

2 

 

32 

 

37 

 

Total P  

 

3462 

 

33071 

 

24 

 

318 

 

33 

 

36908 
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Table 4.2.3: Confusion Matrix of Year 2024 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Total 

U 

 

Water Body  

 

3530 

 

1 

 

0 

 

0 

 

0 

 

3531 

 

Dense Vegetation  

 

0 

 

32843 

 

1 

 

18 

 

2 

 

32864 

 

Built-up 

 

0 

 

1 

 

22 

 

1 

 

0 

 

24 

 

Cropland 

 

0 

 

50 

 

0 

 

244 

 

0 

 

294 

 

Bare Soil 

 

0 

 

5 

 

0 

 

6 

 

29 

 

40 

 

Total P  

 

3530 

 

32900 

 

23 

 

269 

 

31 

 

36753 
 

 

Table 4.2.4: Confusion Matrix of Year 2030 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Total 

U 

 

Water Body  

 

3507 

 

0 

 

0 

 

0 

 

0 

 

3507 

 

Dense Vegetation  

 

0 

 

33180 

 

1 

 

13 

 

1 

 

33195 

 

Built-up 

 

0 

 

0 

 

25 

 

2 

 

0 

 

27 

 

Cropland 

 

0 

 

44 

 

0 

 

250 

 

0 

 

294 

 

Bare Soil 

 

0 

 

7 

 

0 

 

4 

 

37 

 

48 

 

Total P  

 

3507 

 

33231 

 

26 

 

269 

 

38 

 

37071 
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Table 4.2.5: Producer’s & User’s Accuracy (2018) 

 

 

 

Table 4.2.6: Producer’s & User’s Accuracy (2021) 

 

 

 

Table 4.2.7: Producer’s & User’s Accuracy (2024) 

 

 

 

Table 4.2.8: Producer’s & User’s Accuracy (2030) 

 

 

 

Class Producer's Accuracy User's Accuracy 

Water Body 100% 100% 

Dense Vegetation 99.9% 99.8% 

Built-up 92.6% 96.2% 

Cropland 85.0% 92.9% 

Bare Soil 77.0% 97.4% 

Class Producer's Accuracy User's Accuracy 

Water Body 98.9% 100% 

Dense Vegetation 99.9% 99.9% 

Built-up 95.8% 95.8% 

Cropland 97.8% 98.1% 

Bare Soil 86.5% 96.9% 

Class Producer's Accuracy User's Accuracy 

Water Body 98.9% 100% 

Dense Vegetation 98.9% 99.8% 

Built-up 91.7% 95.6% 

Cropland 82.9% 90.7% 

Bare Soil 72.5% 93.5% 

Class Producer's Accuracy User's Accuracy 

Water Body 98.8% 100% 

Dense Vegetation 98.9% 99.8% 

Built-up 95.9% 95.6% 

Cropland 82.9% 90.7% 

Bare Soil 72.5% 93.6% 
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Table 4.2.9: Overall Accuracy and Kappa Coefficient of Time Epochs 
 

The accuracy assessment results indicate a high overall accuracy for the supervised classification, 

demonstrating that the training samples significantly enhanced the algorithm’s ability to distinguish 

between land cover types. The Kappa coefficient further confirmed the reliability of the 

classification, showing strong agreement between the classified map and the reference data. 

Among the individual land cover classes, built-up areas and water bodies achieved the highest user 

and producer accuracies. This suggests that these classes were clearly defined and spectrally distinct, 

making them easier for the classifier to identify accurately. In contrast, dense vegetation and cropland 

showed some degree of confusion, likely due to overlapping spectral signatures and seasonal 

variability that made differentiation more challenging. Bare soil exhibited moderate classification 

accuracy, with occasional misclassifications attributed to its spectral similarity with other exposed 

surfaces. 

Overall, the results affirm the robustness of the classification process, while also highlighting areas 

where spectral overlap may affect class separability. 

 

 

 

 

 

Year Overall Accuracy (%) Kappa Coefficient 

2018 99.9% 99.3% 

2021 99.9% 99.7% 

2024 99.8% 98.8% 

2030 99.8% 98.9% 



46  

4.3  Post Classification Analysis Results 
 

 

Table 4.3.1: Area Change detection 
 

  CLASS AREA 

(ha) 

2018 

AREA 

(%) 

2018 

AREA 

(ha) 

2021 

AREA 

(%) 

2021 

AREA 

(ha) 

2024 

ARE

A 

(%) 

2024 

AREA 

(ha) 

2030 

AREA 

(%) 

2030 

 

Water 

Body  

 

 

63072.5 

 

 

3.7 

 

 

72482.7 

 

 

4.3 

 

 

84241.3 

 

 

4.9 

 

 

87586.6 

 

 

5.2 

Dense 
Vegetation  

 

1271789.7 

 

74.9 

 

1192825.2 

 

70.3 

 

1137391.2 

 

67.1 

 

1122870.8 

 

66.2 

 

Built-up 

 

69764.7 

 

4.1 

 

78226.1 

 

4.6 

 

89897.4 

 

5.3 

 

118387.8 

 

6.9 

 

Cropland 

 

213712.1 

 

12.6 

 

263512.9 

 

15.5 

 

273181.7 

 

16.1 

 

302124.7 

 

17.8 

 

Bare land 

 

77876.0 

 

4.6 

 

89168.1 

 

5.3 

 

111503.3 

 

6.6 

 

65245.1 

 

3.8 

 

The land use/land cover analysis reveals notable shifts across the study period. Water bodies steadily 

increased from 63,072.5 ha in 2018 to 87,586.6 ha by 2030, suggesting stable or expanding aquatic 

zones. Dense vegetation, initially dominant at 74.9%, declined to 66.2%, indicating ongoing 

deforestation or land conversion. Built-up areas nearly doubled, reflecting rapid urbanization and 

infrastructure growth. Cropland expanded consistently, rising from 12.6% to 17.8%, likely due to 

intensified agricultural activity. Bare land fluctuated peaking in 2024 before dropping in 2030 possibly 

due to construction and later land recovery. These trends highlight the pressure of development on 

natural landscapes and the importance of sustainable land management. 
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Figure 4.3.1: A graphical representation of the changes 

 

Table 4.3.2: Transition Matrix of Year 2018 – 2021 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Ground 

 

 Total 

 

Water Body  

3400 20 15 10 46 3491 

 

Dense Vegetation  

30 32000 150 300 299 32779 

 

Built-up 

5 25 68000 100 160 68290 

 

Cropland 

10 200 300 210000 3202 213712 

 

Bare Soil 

46 100 200 300 77000 77646 

 

Ground Total 

3491 32345 68665 210710 80707 395918 

 

From 2018 to 2021, built-up areas expanded rapidly, driven by the conversion of 30.17% of bare land 

and 5.68% of dense vegetation. Cropland also gained slightly from vegetation, while water bodies 

increased modestly, indicating early signs of urban and agricultural pressure on natural landscapes. 

This period marks the beginning of a gradual shift from natural to human-modified land cover, with 

dense vegetation showing early vulnerability to development. 
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Figure 4.3.2: A Chart Representation of the Land Cover Transition of 2018 - 2021 

 

 

 

 

Table 4.3.3: Transition Matrix of Year 2021 – 2024 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Ground 

 

 Total 

 

Water Body  

 

3500 

 

10 

 

5 

 

5 

 

20 

 

3540 

Dense 

Vegetation  

 

20 

 

32500 

 

200 

 

300 

 

500 

 

33520 

 

Built-up 

 

10 

 

30 

 

77000 

 

100 

 

86 

 

77226 

 

Cropland 

 

5 

 

150 

 

250 

 

260000 

 

3100 

 

263505 

 

Bare Soil 

 

30 

 

80 

 

150 

 

200 

 

88000 

 

88460 

 

Ground Total 

 

3565 

 

32770 

 

77605 

 

260605 

 

91706 

 

466251 
 

Between 2021 and 2024, urban growth continued with 28.4% of bare land and 0.61% of vegetation 

transitioning to built-up areas. Cropland expanded further, gaining 0.92% from vegetation, while 

water bodies remained stable. These shifts reflect ongoing land demand for development and 

farming. The persistence of these trends suggests a deepening transformation of the landscape, with 

natural ecosystems increasingly replaced by built and cultivated environments. 
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    Figure 4.3.3: A Chart Representation of the Land Cover Transition of 2021 - 2024 

 

     Table 4.3.4: Transition Matrix of Year 2024 – 2030 

Reference \ 

Predicted 

Water 

Body 

Dense 

Vegetation 

Built- 

up 

Crop- 

land 

Bare 

Soil 

Ground 

 

 Total 

 

Water Body  

 

3600 

 

5 

 

5 

 

5 

 

26 

 

3641 

Dense 

Vegetation  

 

10 

 

32000 

300  

400 

 

533 

 

33243 

 

Built-up 

 

5 

 

20 

 

88000 

 

150 

 

222 

 

88397 

 

Cropland 

 

5 

 

100 

 

300 

 

270000 

 

3776 

 

274181 

 

Bare Soil 

 

20 

 

60 

 

200 

 

300 

 

110000 

 

110580 

 

Ground Total 

 

3640 

 

32185 

 

88805 

 

270855 

 

114557 

 

510042 
 

From 2024 to 2030, built-up areas saw their highest growth, absorbing 25.3% of bare land and 0.91% 

of vegetation. Additionally, 1.25% of dense vegetation was lost to cropland. These transitions 

highlight accelerating urbanization and the continued decline of natural vegetation, emphasizing the 

need for sustainable land use planning. Without intervention, the cumulative impact of these changes 

could lead to long-term ecological degradation and reduced environmental resilience. 
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Figure 4.3.4: A Chart Representation of the Land Cover Transition of 2024 - 2030 
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CHAPTER FIVE 

CONCLUSION AND RECOMMENDATIONS 

5.1 CONCLUSION 

This study presents a comprehensive analysis of land use and land cover (LULC) dynamics in Delta 

State, Nigeria, spanning from 2018 to a projected scenario in 2030. By leveraging remote sensing 

data, geospatial techniques, and machine learning algorithms, the research successfully mapped and 

quantified changes in five major land cover classes: water bodies, dense vegetation, built-up areas, 

cropland, and bare land. The integration of multi-temporal Landsat imagery with supervised 

classification and transition matrix analysis enabled a robust understanding of both historical trends 

and future projections. 

The results reveal a consistent and accelerating expansion of built-up areas across all time intervals, 

with the most dramatic growth occurring between 2018 and 2021. During this period, approximately 

30.17% of bare land and 5.68% of dense vegetation transitioned into urban development, marking 

the onset of rapid infrastructural expansion. This trend continued through 2024 and is projected to 

intensify by 2030, with built-up areas absorbing an additional 25.3% of bare land and 0.91% of 

vegetation. These figures underscore the growing influence of population pressure, economic 

development, and urban sprawl on the region’s landscape. 

Dense vegetation experienced a steady decline throughout the study period, losing over 149,000 

hectares by 2030. This reduction is attributed to both urban encroachment and agricultural expansion, 

with cropland gaining 1.25% from vegetation between 2024 and 2030. While cropland and built-up 

areas expanded, water bodies showed a modest but consistent increase, suggesting either improved 

water retention or the impact of hydrological changes due to land conversion. 

The transition matrices provided critical insights into the spatial and temporal patterns of land cover 

change, revealing not only the magnitude of transformation but also the directionality of land use 
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shifts. The predictive modeling for 2030, powered by machine learning, offers a valuable foresight 

into future land cover scenarios, equipping planners and policymakers with the tools needed to 

anticipate and manage urban growth. 

Overall, the study highlights the dynamic and rapidly evolving nature of land use in Delta State. It 

emphasizes the urgent need for sustainable land management practices to mitigate the environmental 

consequences of unchecked development. The findings serve as a foundational resource for guiding 

policy decisions, urban planning strategies, and conservation efforts aimed at balancing growth with 

ecological integrity. 

Let me know if you'd like this adapted for your thesis formatting or expanded into a PowerPoint 

slide. I can also help you write the abstract or executive summary if needed. 

5.2 RECOMMENDATIONS 

As this study concludes, it is imperative to emphasize the need for proactive and sustainable land 

management strategies in Delta State. The findings underscore the urgency of balancing 

development with environmental conservation, especially in light of the projected expansion of built-

up areas and the steady decline of natural vegetation. 

Urban planners and policymakers should prioritize green infrastructure initiatives, including 

reforestation programs, urban green belts, and conservation of remaining forest reserves. Zoning 

regulations must be strengthened to prevent unregulated urban sprawl and protect ecologically 

sensitive areas from further encroachment. 

Agricultural expansion should be guided by climate-smart practices that minimize land degradation 

and preserve soil health. Government agencies should promote sustainable farming techniques and 

support land restoration efforts in degraded zones. 
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Infrastructure development must be integrated with environmental planning to ensure adequate 

provision of drainage systems, waste management, and transportation networks. Geospatial data 

should be embedded into decision-making frameworks to enhance the accuracy and responsiveness 

of urban planning. 

Finally, continuous LULC monitoring using high-resolution satellite imagery and machine learning 

should be institutionalized. Environmental impact assessments (EIAs) must be mandatory for all 

major land development projects to safeguard Delta State’s ecological integrity. By implementing 

these recommendations, stakeholders can ensure that future growth is both inclusive and sustainable, 

preserving the region’s natural resources for generations to come. 
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